BACnet for the PCD series
0 Index
0.1 Document history ................................................................. 0-3
0.2 Trademarks ........................................................................... 0-3

1 Introduction
1.1 Purpose of this document .................................................. 1-1
1.2 What is BACnet ................................................................. 1-1
1.3 The ISO/OSI-Model ............................................................ 1-1
1.4 BACnet device profiles ....................................................... 1-1
1.5 BACnet standard objects .................................................... 1-2
1.6 BACnet services ............................................................... 1-2
1.7 Description of a service: BIBB .......................................... 1-2
1.8 Description of a device type: PICS .................................... 1-2

2 BACnet implementation of the PCD
2.1 Supported controllers, Requirements and Limitations .......... 2-1
2.2 Limitations ........................................................................ 2-2
2.3 Tool Requirements ............................................................ 2-2
2.4 PCD Data model in BACnet ............................................... 2-2
2.5 PCD Time Model ............................................................... 2-3
2.6 Modem drivers ................................................................. 2-4

3 Basic Workflow
3.1 Overview of the basic Workflow of a BACnet Project ............. 3-1
3.2 Engineering of User Program ............................................. 3-1
3.3 Selecting all necessary Information for BACnet .................. 3-1
3.4 BACnet Configurator Overview ........................................ 3-2
3.5 Generation of Devices ....................................................... 3-3
3.6 Generation of Server Objects ............................................. 3-5
3.7 Generation of Client Objects .............................................. 3-5
3.8 Assigning PCD Resources to BACnet Properties ................. 3-6
3.9 Parameterize Properties .................................................. 3-6
3.10 The Build Process .......................................................... 3-7
3.11 Download and Upload ........................................................ 3-8
3.12 EDE Export .................................................................... 3-10
3.13 EDE Import .................................................................... 3-10

4 Advanced Features
4.1 Generating an Assignment of a Series of Objects .................. 4-1
4.2 Manual Operation with D23x, Web and BACnet .................. 4-3
4.3 Alarming over BACnet and Fupla Boxes ......................... 4-4
4.4 Trending .......................................................................... 4-4
4.5 Backup / Restore ............................................................. 4-4
4.6 Advanced Client Configuration ....................................... 4-4
4.7 Time Master / Slave ........................................................ 4-6
4.8 Time Zone Setting ............................................................ 4-7
4.9 BBMD/FD ....................................................................... 4-7
4.10 Modem Communication .................................................. 4-9
   4.10.1 PG5 HW settings ...................................................... 4-9
   4.10.2 BACnet Configuration .............................................. 4-10
4.11 Excel Export/Import ......................................................... 4-11
5 Maintenance
5.1 Firmware Update ................................................................. 5-1
5.2 History List Error Messages.................................................. 5-3
5.3 Transmission Logging......................................................... 5-3
5.4 Literature............................................................................. 5-4

A Appendix
A.1 Icons ................................................................................ A-1
A.2 Contact .............................................................................. A-2
## 0.1 Document history

<table>
<thead>
<tr>
<th>Edition</th>
<th>Publication</th>
<th>Changed</th>
<th>Modifications</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>PE1</td>
<td>01.10.2006</td>
<td>Preliminary</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Edition</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PE2</td>
<td>31.03.2007</td>
<td>Additions to</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PE1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E1</td>
<td>01.06.2007</td>
<td>Few changes</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>to PE2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E2</td>
<td>18.10.2007</td>
<td>Ch 2.1, Ch</td>
<td>New controllers,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.2, Ch 2.3,</td>
<td>Limitations added</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ch 2.4, Ch</td>
<td>Configurator version 1.4.1.0,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4.6</td>
<td>1.4.1.3</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>New values for the example</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note added</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>New screenshot, text added</td>
<td></td>
</tr>
<tr>
<td>EN03</td>
<td>2014-05-08</td>
<td>whole doc.</td>
<td>New logo and new company name</td>
<td></td>
</tr>
</tbody>
</table>

## 0.2 Trademarks

Saia PCD® and Saia PG5® are registered trademarks of Saia-Burgess Controls AG. BACnet is a registered trademark of American Society of Heating, Refrigeration and Air-Conditioning Engineer (ASHRAE).

Technical modifications and changes are subject to the state of technology

Saia-Burgess Controls AG, 2014.

© All rights reserved

Published in Switzerland
1 Introduction

1.1 Purpose of this document

This document contains all available information helping to implement a BACnet device on a SaiaPCD® and integrating it into a BACnet network.

1.2 What is BACnet

BACnet is the abbreviation of Building Automation and Control Network

BACnet is a data protocol for the exchange of data between different systems and devices in the field of building automation

BACnet describes the projection of objects and its interaction with other objects and not their internal functionality

BACnet is a registered trademark of ASHRAE

1.3 The ISO/OSI-Model

BACnet is defined for several physical layers.

BACnet/IP has only later been added to the original group.

1.4 BACnet device profiles

Today 6 device profiles are defined with BACnet:

BACnet Operator Workstation (B-OWS)
BACnet Building Controller (B-BC)
BACnet Advanced Application Controller (B-AAC)
BACnet Application Specific Controller (B-ASC)
BACnet Smart Actuator (B-SA)
BACnet Smart Sensor (B-SS)

For each device profile certain services are mandatory
1.5 **BACnet standard objects**

ANSI/ASHRAE 135-2004 defines 25 BACnet standard objects

- Data point oriented objects:
  - Analog / Digital / Multistate Input / Value / Output

- User data oriented objects:
  - Calendar, Group, Schedule, Trendlog

- Program oriented objects:
  - Device, Command, Program, Loop, Notification Class,
  - Accumulator, Average, Pulse Converter

- Filehandling (File) und Alarmhandling (Alarm Enrollment)

- Life Safety objects:
  - Life Safety Point, Life Safety Zone

1.6 **BACnet services**

- All services are client server applications
- Each device can act simultaneously as client and server

BACnet services are divided into five segments:

1) Object access
2) Filetransfer
3) Alarm- and event-functions
4) Remote device management
5) Virtual terminal

For each device profile certain services are mandatory

1.7 **Description of a service: BIBB**

Annex K of the BACnet standard defines all services in a formal way using the term „BACnet Interoperability Building Blocks”

Each BIBB is defined either from the Client (-A) or the Server (-B) Part.

Example: DS-RP-A is the description of the Data Sharing Read Property Service (Client) whereas DS-RP-B describes the Server part of the same service.

1.8 **Description of a device type: PICS**

A PICS is a document with a given structure defined in Annex A of the BACnet standard.

This is a publicly available document summarizing the functionality contained in a well defined device type, such as physical layers, objects and services supported.

The current version is 1.5: 26-848_E5_PICS_BACnet-PCD3.pdf
2 BACnet implementation of the PCD

2.1 Supported controllers, Requirements and Limitations

The following Controllers are supported and have been tested by WSPLab to comply with the BACnet Standard:

- PCD3.M3120
- PCD3.M3330
- PCD3.M5340
- PCD3.M5540
- PCD3.M6340
- PCD3.M6540

All information with respect to BACnet is stored on a Flash Memory. This is available in 4 Versions:


The BACnet firmware will be downloaded with the same tool as the PCD3 main firmware.
2.2 Limitations

The amount of usable BACnet Objects depends on the CPU Performance of the PCD3 System.

If you have a lot of communication or other CPU intensive applications the amount of objects decreases significant.

Always take care to limit the amount of objects regarding to the CPU performance!

We recommend to use not more than 800 BACnet-Objects in one PCD3.

2.3 Tool Requirements

2.3.1 PG5

A PG5 1.4 SP 120 or higher is required.

2.3.2 Configurator

A Configurator Version 1.4.1.3 or higher is required.

2.4 PCD Data model in BACnet

2.4.1 Binary Data

A Binary property of the BACnet can either be mapped to a Flag or with an Input/Output.

2.4.2 Integer Data

An Integer property of the BACnet can be mapped to a Register. Converting of IEEE (BACnet floating point format) and SBC Integer (PCD format) is done with the scale of the BACnet configuration.

Ex: Scaling Factor in 10, BACnet Value is 47.7 so the register contains the value 477.

The COV Increment is always related to the BACnet Value.

2.4.3 Text Data

To show text data is only possible as text of a PCD.
2.4.4 Trendlog Data

Trendlog data can be stored either in the SRAM or on a flash file system.

The location can be changed in the Log Buffer property:

![Properties: Log Buffer]

Value is:
- SRAM for SRAM Trendlog data
- M1_FLASH:/Trend-Log-Data for Slot M1
- M2_FLASH:/Trend-Log-Data for Slot M2
- SL0FLASH:/Trend-Log-Data for IO Slot 0
- SL1FLASH:/Trend-Log-Data for IO Slot 1
- SL2FLASH:/Trend-Log-Data for IO Slot 2
- SL3FLASH:/Trend-Log-Data for IO Slot 3

1) Ring buffer only possible with SDRAM (Trendlog Property STOP_WHEN_FULL→FALSE)
2) No ring buffer possible (Trendlog Property STOP_WHEN_FULL→TRUE)

2.5 PCD Time Model

Over BACnet the PCD can show either local time or UTC. However the PCD shows only local time (with RTIME or PG5!)

The time zone is configuring in the timezone property of the device object.

Attention: The time zone will store if the time will set. This can be done either over the PG5 or a BACnet GLT.

Make sure to set the time with PG5 after first download of a BACnet Project to the PCD!
2.6 Modem drivers

It is possible to use the same Modem for S-Bus and BACnet. The modem configuration will do in the PG5 Modem settings. To use the modem also for BACnet the PTP settings in the BACnet configurator is used. The FW detects then itself if the call is coming from a S-Bus Client or BACnet!
3 Basic Workflow

3.1 Overview of the basic Workflow of a BACnet Project

The following covers all basic steps of generating a simple BACnet device. All advanced features including all efficiency functions are covered in Chapter 4.

After the application program has been written and all needed information has been gathered in global symbols, the BACnet configurator is started. After configuring the identity of the BACnet device the required objects are created.

It’s properties can either being mapped to PCD resources for On-line changing from within the PCD3 or the value can be configured with a fixed value or with a variable value which later can be accessed and changed from within a BACnet client.

The configuration will be compiled after the program has been linked and is downloaded separately to the PCD3 where it is stored directly on the BACnet Flash.

3.2 Engineering of User Program

If a strong linking of the Fupla program with the BACnet mechanisms is not required, the program can be written prior of the configuration of the BACnet Projection.

Exceptions are when a user interaction is superseding (overwriting) a result of the program logic. Here special Fupla FBoxes are required in order to allow the BACnet priority mechanism to interact with the Fupla program.

3.3 Selecting all necessary Information for BACnet

Any information on BACnet needs to be either a global or a system variable. A structured view of all resources does help during commissioning!

The usage of groups of symbols not only helps better structuring the data but also enables usage of Templates to faster create and parametrize objects. More details refer to Chapter 4.11.
3.4 **BACnet Configurator Overview**

The BACnet configurator contains all information necessary for the BACnet communication.

![BACnet Configurator Window](image)

It is started by clicking on an existing configuration in PG5 or by selecting the “New” function in the “File” menu. In the dialog box select BACnet as File Type and give it a name.

Since this tool is supposed to help both newcomers to BACnet and Experts there are also two levels of engineering:

The „Standard View“ will only present a reduced set of parameters for the User but is sufficient for simple projects.

The „Expert View“ will present all parameters, also those which requires a skilled user such as Modem Configuration and others.
The Main Window is separated in two main fields. At the left part, all devices and its containing objects are displayed. On the right part the Properties of the current object on the left side are displayed.

Double clicking on a property will display a specific dialog box to configure this property.

A special dialog box will configure the „Data Link“ configuration but since this requires advanced skills this dialog is not available in the „Standard View“.

3.5 Generation of Devices

BACnet relies strongly on Client-Server architecture. Hence both parts are also configurable with the PCD3:

A Server device will store all necessary information of all objects and its properties for access of a client.

The client device is not a device object but represents all information regarding the communication with a specific (external) server device and its objects.

Parameterizing the (Server) Device object in standard mode is fairly simple since only the description and the location of the device can be entered. In „Expert“ Mode the time zone, the Time Master/Slave configuration and some parameters regarding communication behavior and telegram length can be changed.
The (Slave) device object offers the possibility to Enable/Disable the complete communication to a specific server and to attach this to a PCD Flag. A register can also be attached to the communication status information.

For each Server connection also two properties can be mapped to PCD Ressources:
- Setting the Flag „Communication Enabled“ to the Value „True“ will initiate the communication to the server and keep all COV subscription concurrent. Setting the Flag to „False“ will immediately terminate the communication by first trying to de-subscribe all COV subscriptions.
- A register „Communication Status“ represents the state of the communication:
  - 0: Communication not established
  - 1: Initiating Communication
  - 2: Communication using Polling established
  - 4: Communication using COV established
  - 9: Communication Error
3.6 Generation of Server Objects

Server Objects are generated using a template, either the default template for this object or a user defined template which better suits for the intended purpose.

In „Standard View“ only a small part of the Properties are visible, all required properties will be parameterized with useful default values.

Besides the Object ID and name also some general selections can be made at this stage. A Checkbox to select „Intrinsic Alarming“ and a „Commandable Present Value“ is displayed where appropriate.

For the Generation of several objects at the same time also the position of an index variable in the object name can be made.

3.7 Generation of Client Objects

In „Standard View“ only the „Present Value“ of an object can be selected. All parameters regarding how the communication is set up are only visible in „Expert Mode“ where also all possible properties are visible.
3.8 Assigning PCD Resources to BACnet Properties

Each simple type variable can be assigned to a PCD resource:

A Flag for any binary information

A Register for any integer value

A Register for any real value with an selection of the conversion factor. Since the real value of BACnet is stored internally as an integer, a factor of 10 is necessary to store with an accuracy of tenth of the unit.

3.9 Parameterize Properties

For properties which need more complex configuration special dialog boxes are available. With them the user is guided to correctly configure those properties.

Since the generic scheduler object offers too many possibilities and hence often confuses a user, three more specific templates are available for an „Analog Scheduler“, a „Binary Scheduler“, and a „Multistate Scheduler“. 
3.10 The Build Process

Since the BACnet Configurator and Compiler are fully integrated PG5 Add-On Tools, the BACnet Configuration file is integrated in the build process. Due to the Usage of global and system variables the BACnet configuration is compiled AFTER successfully compiling and linking the user program.

The compiler will plot dots during its process so a progress can easily be seen for larger projects.

There are several conditions which cause the compiler to issue a warning or even an error message:

If the configuration in its binary form uses more than 80% of the available 256 kB a warning is issued. If the configuration is too big, an error message is displayed.

If two (or more) properties are assigned to the same PCD resource also an error message is displayed.

A mismatch of a data type should not be possible while using the configurator, but an error message will be displayed when encountered.
3.11 Download and Upload

Downloading the BACnet configuration is fully integrated into PG5 and is done automatically along with the user program.

When the function „Selected Download“ will be used, the BACnet Configuration will be in the Group of „Downloadable Files“.

An Upload function is activated in the Configurator and first uploads the current configuration including all user specific adaptations. This configuration is then merged into the active configuration file.
Download and Upload

Basic Workflow

These rules apply:

- The upload MUST be made before any changes of the program is compiled.
- All objects which were generated on-line (using the „Create Object“ function of BACnet) are imported and treated as configured objects, hence are not deletable online (using the „Delete Object“ function of BACnet) anymore.
- The content of all properties which are not associated to a PCD Ressource are taken from the uploaded file.

The Upload is then done automatically using PG5 System functions based on the current On-Line settings.
An error message will appear if the selected controller cannot be found using those settings.

### 3.12 EDE Export

When compiling a CPU the associated BACnet device will be stored in the EDE format in the „Doc“ subdirectory of the CPU directory. Both Version of the standard (1.0 without and 2.0 with state texts) are saved and besides the object declaration also the state texts and unit texts are saved.

### 3.13 EDE Import

When configuring the Client configuration, the EDE files on any server can be directly imported creating all available objects in the respective server.

In standard mode only the „Present Value“ of the objects can be accessed, in „Expert Mode“ all properties are accessible.
4 Advanced Features

The PCD3 Implementation supports all Standard Objects except Life Safety Point and Life Safety Zone.

For a detailed description of all properties of those objects, using the BACnet Standard 135-2004 is highly recommended!

4.1 Generating an Assignment of a Series of Objects

If several objects of the same type need to be generated, the use of the Template mechanism is recommended. One object is generated either from the default template or from an earlier template. This object is then parameterized in detail and stored as a template. First a template needs to be created using any existing object.

Don't use in the Preset name “/”.

This is done using the context specific menu “right-clicking” on the object itself. There's no template editor, but changes can be made using any type of text editor. The key is that numbers within a register reference or even a symbol name can be generated using the object ID number.

The following is a part of the Object configuration of a Binary Input:

[BI]

present-value = %((Device.I0) || R
The present Value is mapped to the symbol reference “Device.I0”.
Let’s assume that several inputs are to be mapped accordingly. The necessary global symbols were already created: “Device.I10” – “Device.I18”

Now the above line can be edited as follows

```
present-value = %(Device.I{0}) || R
```

The value inside the {} brackets does definnie the minimum number of digits representing the Object ID.

When Binary Objects 10 – 18 are created using this template, the present value will already refer to the correct symbol!

If for some reasons the Object ID does not match the number within the global symbol, also a +/- can be used:

```
present-value = %(Device.I{0+9}) || R
```

then means if objects with the ID's 1-9 are generated, the present value will still refer to the already generated “Device.I10” – “Device.I18”.

Any integer value can be entered.

Using the template is straightforward:

The template will appear for the appropriate object type along the default templates.

4.2 Manual Operation with D23x, Web and BACnet

Using either “Analog Value”, “Binary Value”, or “Multistate Value” objects without “Commandibility” of its “Present Value”, a local operation (with a Web or D23x) of the resource attached to the “Present Value” property is simultaneously possible.

Since the Resource needs to be mapped to either a global or a system variable, the first step is to generate this resource, either in the Symbol Editor directly or by using a
Fupla FBox which at compilation time generates automatically a system variable. This variable can now be addressed in HMI Editor (for the use with a D23x), the Web Editor (for the use of any Web Client) or in the BACnet Configurator (for the Use over BACnet).

If a data point of the user program needs to be overridden using BACnet (and also Web Technology), a special FBox needs to be placed in the Fupla program where the user intervention is intended to be active.

The same FBox is required if a data point of a remote controller which is connected through S-Bus needs to be available on BACnet.

4.3 Alarming over BACnet and Fupla Boxes

The Alarming over BACnet and the SBC specific alarming mechanism is not compatible with each other and hence no BACnet Alarm can be reset over the SBC specific Boxes or versa. Of course assigning the „Present Value“ of a Binary Value object to a Flag assigned to a global reset is always possible.

4.4 Trending

The Trendlog object allows the recording of historical data of the PCD3. Only „Present Value“ properties of BACnet objects can be recorded, there is no direct access to PCD resources.

4.5 Backup / Restore

There is a SBC specific Backup mechanism using the Program Backup option on internal or external Flash such as the PCD7.R500 or the PCD7.R561 BACnet Flash with Backup option. This one is configured using the PG5.

On the other hand there’s the Backup / Restore Mechanism defined in BACnet, where a B-OWS management station supporting the functionality DM-BR-A can initiate any device supporting DM-BR-B such as the PCD3 to Backup all its configuration data (user program, media mapping, BACnet object structure and configuration) to the management station and also restore this data any later date from the B-OWS. This functionality does not need any specific configuration on the PCD3!

4.6 Advanced Client Configuration

When configuring a client object in “Expert Mode” not only the “Present Value” is available as described in Chapter 3.7, but all Properties.

Also more options regarding the way the communication is established are available in the detailed configuration window:
There are two ways of retrieving data from a server or sending data to a server:

- Polling
- Subscribing “Change of Value”

With the default configuration above the following mechanism during startup is processed:

1) The Client sends a “Who Is” in order to find the Server
2) First some info such as the max. APDU length and segmentation support is fetched
3) Then the Bitstring about the ProtocolServiceSupported is read in order to find out whether COV is supported with the server or not.
4a) If COV is supported subscriptions for the Object-Properties for the given server are sent.
5a) If the Subscription is acknowledged the communication is considered „Established”
6) If the subscription is rejected for any reason or the server does not support COV subscriptions, the Object-Property will be polled with a certain cycle.

If the Checkbox for COV Resubscription is deselected, the Client will directly switch to Polling without trying to establish a COV connection.

On the other hand if the Checkbox for „Polling” is deselected, the Client will not switch to polling even if the COV subscription for any reason fails.

The Scale Factor is used to scale the PCD integer value to the Bacnet Value.

Ex: Scaling Factor of 10 , register contains a value of 477 so the BACnet Value is 47.7
The PCD-Increment should be used if you write values from the PCD to a Server. The Increment defines how much the scaled value must change to activate a transmission. It is important to reduce the network traffic.

Ex. If the PCD-Increment has a value of 5.0 the and the scaled BACnet value is 20.0, the next transmission is started if the BACnet value is lower than 15.0 or higher than 25.0.

There are known project specific reasons to change the default values but is strongly discouraged to change anything without being well clear about the consequences!

### 4.7 Time Master / Slave

The default setting is “Time Slave” where only messages from other Time Masters are processed. This setting has no further configuration parameters.

Only a one time synchronisation with the configuration PC using the Functionality in the “On-Line Configurator” in PG5 is required to activate the combined “Local Time”/“UTC Time” Real Time Clock.

When changing the Setting to “Time Master” more options are available

A Checkbox sets whether the synchronisation telegram will be set up as local time or as UTC.

The second parameter is either the interval of this message in minutes or when using the HH:MM:SS syntax, the telegram will be sent once a day at the time specified.
Of course without configuring the Property “Time Synchronisation Recepients” no message will be transmitted when configuring as “Master”.

Either individual devices can be entered either with their device ID or using the BACnet MAC address. Entering the local broadcast address as recipient will force the PCD3 to send a Synchronisation message as local broadcast message which also will be forwarded from BBMD stations to the other IP subnets on the same BACnet network.

4.8 Time Zone Setting

The only time zone available with the factory settings of the BACnet configurator is “Central Europe”. If another time zone needs to be selectable in the BACnet configurator, an adaption of the Configurator is neccessary.

By default only the Western European Time zone is available when selecting the Time Zone. All possible time zone settings are stored in a text file which is stored in the .... directory. Using a Text Editor all lines of configuration can be copied into the “SBACnet_Config.bnp” in the part of the xml configuration starting with <!--Timezone use @@ instead of , -->.

4.9 BBMD/FD

By default the PCD3 is configured as “Simple device”.

Operating Mode: Simple Device (Default)

No parameters are available and no BBMD related functionality is activated on the PCD3 with this setting.

Selecting the “BBMD option”, more configuration parameters are available
A list with the IP address of all other BBMD’s in the network can be entered and on the bottom there’s an option for using “One Hop” IP routers. Since those are not well spread, this option can be left unchecked in most applications.

Only if the “One Hop” option is selected, a subnet mask other than the preset 255.255.255.255 should be entered.

When selecting BBMD, also the FD Support is activated by default, but contains no configuration parameters. If there’s only one BBMD in a project, but several remote devices are to be configured as FD, the list of BBMD devices can be left empty.

The third possible selection is FD.
4.10 Modem Communication

4.10.1 PG5 HW settings

S-Bus settings

1) Activate S-Bus Support
2) Enter S-Bus Station Number

Modem settings

1) Select Public Line S-Bus Modem
2) Select Serial Port and Baud Rate
3) S-Bus Mode is Data
4) Select Modem
5) Download to the PCD with Download…
6) Confirm with OK
4.10.2 BACnet Configuration

1) Open the BACnet configurator
   (Doubleclick on the BACnet configuration in the PG5 Projekt Manager)
2) Open Datalink Configuration
3) Select PTP
4) Network No: Set IP (Attention: has to be the same as the BACstac setting in PTP!)
5) Change to PTP
6) Select SBC Serial Port (has to be the same as the HW settings!)
7) Connect Timeout on e.g. 60 (min.)
8) Select Autoconnect
9) Set Password (IN): Add for addition (e.g. saia) Identification will be ignored.
10) Set Phone Number (OUT), if necessary
11) Confirm with OK
AutoConnect

1) Select user defined
2) Select functions by your own choice
3) Confirm with OK

The same configuration for the “Autoconnect Settings” is also available in the IP Settings. These settings are taken, when several devices are connected with IP and share a common modem for the communication to a remote network. These settings are not used if the network has no modems.

4.11 Excel Export/Import

It is not recommended to directly manipulate the bnt file when an automated manipulation of the BACnet configuration is required.

The Export/Import is intended to be used instead producing a set of csv files which each represent a single object type with all object instances in a row.

Any manual interaction with those files is discarded since the Import from Excel no error checking will be performed.
5 Maintenance

5.1 Firmware Update

**Firmware Download**

1) Select menu: “Tools” => “Update Firmware”.

2) Select BACnet firmware files (*.blk) with “Add”
3) Delete other FW files (*.blk) with “Del” (be sure that there is only the BACnet_xxx.blk file in the list.

4) Change the Connection settings if necessary with File → Settings

5) Start the FW download with “Start”

6) Press OK if the PCD is running

7) Wait until the Download is finished

8) The PCD is rebooting itself

9) Download your project
5.2 History List Error Messages

If there is a problem with the BACnet the follow error messages are written in the PCD history:

BNt FAIL xxyyyyy

Where:  
xx is the Object ID or ## for general errors
yyyy is the error or the Object number

Example:  
BNt Fail ##00020 → Out of Memory
BNt Fail AI00001 → Error in Object AI (Analog Input) 1

General error description:

<table>
<thead>
<tr>
<th>ERR#</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>UNKNOWN_ERROR</td>
</tr>
</tbody>
</table>
| 2    | SERVICE_NOT_FOUND  
If there is a problem in the Datalink-Layer (IP/PTP) configuration. |
| 10   | INVALID_PARAM  
If there is a problem in the Datalink-Layer (IP/PTP) configuration. |
| 12   | ALREADY_EXISTS  
An object with the same object ID does already exist. |
| 13   | BAD_CONFIG  
Bad configuration |
| 14   | OBJECT_NOT_FOUND  
Object not found |
| 15   | PROPERTY_NOT_FOUND  
A property is set that does not exist for the given object. |
| 20   | OUT_OF_MEMORY  
No more memory avaible |
| 21   | OUT_OF_RESOURCES  
No more system resources (Mutexes, Timers...) mehr |
| 34   | INVALID_DATA_TYPE  
A property of an object contains illegal data. |
| 35   | VAL_OUT_OF_RANGE  
A value of a property is out of range. |
| 36   | VAL_OUT_OF_SPACE  
A value of a property uses more memory than reserved. |
| 40   | BACNET_ERROR  
A value of a property is not BACnet conform. |

5.3 Transmission Logging

There are several products available with which the traffic on a IP network can be logged. Two of them can be recommended for the use with BACnet:

- Wireshark
  
  An “open source” program which is available for most operating systems and is able to dessect BACnet telegrams to a certain degree. It can be downloaded free of charge from the Internet (www.wireshark.org).

- Bas-o-matic
  
  This program manufactured by Cimetrics is not only used by the BACnet Testing Laboratories, but also by a wide range of BACnet users. For details refer to the Cimetrics homepage (www.cimetrics.com) or contact a SBC sales representative for an offer.
5.4 Literature

- ANSI ASHRAE 135-2004: BACnet A Data Communication Protocol for Building Automation and Control Networks ISSN 1041-2336
- 26-848_E5_PICS_BACnet-PCD3: Saia-Burgess Controls AG BACnet PCD3 Protocol Implementation Conformance Statement (PICS)
## Appendix

### A.1 Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="i" /></td>
<td>In manuals, this symbol refers the reader to further information in this manual or other manuals or technical information documents. As a rule there is no direct link to such documents.</td>
</tr>
<tr>
<td><img src="Image" alt="bolt" /></td>
<td>This symbol warns the reader of the risk to components from electrostatic discharges caused by touch. <strong>Recommendation:</strong> at least touch the Minus of the system (cabinet of PGU connector) before coming in contact with the electronic parts. Better is to use a grounding wrist strap with its cable attached to the Minus of the system.</td>
</tr>
<tr>
<td><img src="Image" alt="exclamation" /></td>
<td>This sign accompanies instructions that must always be followed.</td>
</tr>
<tr>
<td><img src="Image" alt="classic" /></td>
<td>Explanations beside this sign are valid only for the Saia PCD® Classic series.</td>
</tr>
<tr>
<td><img src="Image" alt="xx7" /></td>
<td>Explanations beside this sign are valid only for the Saia PCD® xx7 series.</td>
</tr>
</tbody>
</table>
A.2 Contact

Saia-Burgess Controls AG
Bahnhofstrasse 18
3280 Murten
Switzerland

Phone ........................................+41 26 672 72 72
Fax...........................................+41 26 672 74 99

Email support: ....................... support@saia-pcd.com
Supportsite: ..................... www.sbc-support.com
SBC site: ......................... www.saia-pcd.com
International Represetatives &
SBC Sales Companies: ............. www.saia-pcd.com/contact

Postal address for returns from customers of the Swiss Sales office

Saia-Burgess Controls AG
Service Après-Vente
Bahnhofstrasse 18
3280 Murten
Switzerland